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Bevezetés 

 

A sejttani kutatások alapját a különböző sejtpopulációk képezik. A sejtek viselkedését és 

toxikus ágensekkel szembeni ellenálló képességét a sejtek belső és külső körülményei 

jelentősen befolyásolják. A belső körülményeket a sejtek fiziológiás állapota jelenti, azonban 

a külső körülményeket a sejt-sejt közötti, azaz intracelluláris viszonyok jelentősen 

befolyásolják.  

A time-lapse imaging rendszer egy, a sejtpopulációk hosszú távú megfigyelésére alkalmas 

rendszer. A vizsgálat során a sejttenyészetekről percenként készített felvételekből videofilmet 

készítve tanulmányozzuk a sejtpopulációkban végbemenő változásokat. 

A rendszer előnyei közül kiemeljük, hogy a vizsgálat teljes időtartama alatt lehetőségünk van 

a sejtek megfigyelésére, illetve a megfigyelésünk digitális rögzítésére. E mellett nagyon 

fontos az is, hogy a vizsgálatok teljes időtartama alatt biztosítjuk a sejtek számára megfelelő 

fiziológiás körülményeket. 

 

Time-lapse imaging rendszer 

 

A Debreceni Egyetem Mikrobiális Biotechnológiai és Sejtbiológiai Tanszék eTox 

munkacsoportja 2005-ben kifejlesztett egy mikroszkópos rendszert, mely lehetővé teszi 

citotoxikus anyagok hatásának valós idejű, celluláris szintű vizsgálatát a teljes sejtciklus alatt. 

A munkacsoportunk számára fontos kutatási terület a különböző toxikus hatások vizsgálata A 

kutatásunk alapját a toxikus ágensek hatására bekövetkező kromatin kondenzálódási 

rendellenességeinek vizsgálatai jelentik. A mikroszkópos rendszer létrehozásának egyik oka, 

hogy a sejtek közötti variabilitás, illetve a sejt-sejt közötti interakciók jelentős mértékben 

befolyásolják az eredményeket.  

A rendszer segítségével a standard tenyésztési körülmények között tartott tenyészetek 

mikroszkópos megfigyelése akár százhatvannyolc órás intervallumban, hat másodperces 

időbeli felbontásban történhet. Az így nyert képsorozat videofelvétellé alakítható, mely a 

citotoxicitás közvetlen, sejt és populációs szintű tanulmányozására alkalmas. A képadatbázis 

statisztikai képelemző módszerekkel való feldolgozása nagy időbeli felbontású adatokat 

biztosít a toxikus folyamatok dinamikai vizsgálatához (1). Az adatgyűjtés három, hat 
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sejtgenerációt átfogó időtartama lehetővé teszi a transzgenerációs, akkumulálódó 

genotoxicitás, illetve kemotaxis vizsgálatát is (2). 

A TLS rendszer előnyei: 

 Időkorlátja nincs, a sejtek számára a fiziológiás körülmények biztosítottak. 

 A sejtek egyedileg vizsgálhatók. 

 Az életfolyamatok az idő függvényében jellemezhetők. 

 A time-lapse imaging módszer segítségével az apoptózis és a nekrózis is részletesen 

tanulmányozható. 

 

 

Apoptózis és nekrózis 

 

Természetes sejthalálformákat már a 19. században megfigyeltek fénymikroszkóp 

segítségével. 

Azonban az 1960-as évekig váratott magára a programozott sejthalál koncepciója, amikor a 

molekuláris gondolkodásmód kiteljesedett. Az apoptotikus sejt összezsugorodik, az 

extracelluláris mátrixról és a sejtet körülölelő szomszédos sejtekről leválva (szeparáció) 

lekerekedik, hólyagosodik a felszíne, magja kisebbedik (karyopyknosis), kromatin állománya 

kondenzálódik és a maghártya mentén rendeződik (marginalizáció), ezt követően a mag 

feltöredezik (karyihexis), emellett viszont a sejt organellumai és a sejthártya integritása 

megmarad. Végül pedig a makrofágok és más szomszédos sejtek is bekebelezik, valamint 

apoptotikus testek fragmentálódnak. A sejthártya a folyamat ideje alatt  végig ép marad így az 

intracelluláris makromolekulák nem jutnak ki, tehát következményes gyulladás és 

szövetkárosodás nem jön létre. Az apoptózis aktív, azaz „energiaigényes” és gyulladásmentes 

folyamat.  

Az apoptózissal szemben a nekrózis passzív folyamat. Durva behatások által létrejövő 

nagyobb sejtpopulációt érintő sejthalál. A sejt és ezen belül a sejtmag megduzzad, lizoszómák 

szétesnek, végeredményben pedig a sejt mintha csak szétpukkanna, bekövetkezik a sejt lízise. 

A sejtmembránok integritása nem marad meg, kiáramló sejttartalomnak köszönhetően 

sejtkárosodás, gyógyulás során fellépő hegesedés és gyulladásos reakció következik be. 

Nemrégiben leírt tanulmányok kimutatták, hogy az apoptózis és a nekrózis morfológiájának 

kettősége nem elég arra vonatkozólag, hogy be tudjunk sorolni minden sejthalálformát. 
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Több adat alapján valószínűsíthető, hogy nemcsak az apoptózis lehet programozott sejthalál, 

hanem a nekrózis is. Ilyen sejthalált okozhatnak ligandok, melyek specifikus 

membránreceptorokhoz kötődnek. Nekrózisos sejthalál figyelhető meg kifejlődött szövetek 

homeosztázisában és az embrionális fejlődésben. A nekrózis a Szerin/ Treonin kináz 

aktivitástól függő sejthalálforma. Ezen típust nemcsak genetikailag, hanem epigenetikailag és 

gyógyszeresen is lehet szabályozni. 

 

Az apoptózis indukciója: 

 

A programozott sejthalál kiváltásában és szabályzásában endogén és exogén tényezők 

lényeges szerepet töltenek be. Ezek a tényezők hatásukat tekintve gátló és serkentő hatásúak. 

Külső tényezők jelenlététől függ (legyenek azok különböző növekedési faktorok, hormonok 

vagy citokinek), hogy bekövetkezik-e az apoptózis vagy sem. Apoptózis indukálóként is részt 

vehetnek a folyamatban vagy épp ellenkezőleg, annak indukálódásában játszanak szerepet. 

Kulcsfontosságú szerepet tölt be a TNF (tumor nekrózis faktor) citokin család, amely családot 

„halál ligandnak” is nevezik továbbá a FAS ligand is jelentős szereppel bírhat az apoptózis 

folyamatában. Ez a ligand olyan sejtfelszíni receptorokhoz kötődik, melyek a közös 

jellemzője, hogy halál domént (DD) tartalmaznak az intracelluláris terükben. A programozott 

sejthalál másik útvonalát képezheti a mitokondrium segítségével megvalósuló folyamat, azaz 

a sejtet érő végzetes ágensek (különböző sugárzások (γ vagy UV), reaktív oxidatív gyökök, 

toxinok, gyógyszerek, mérgek) hatását követően bekövetkező apoptotikus forma Egy p53 

nevezetű fehérje nemcsak a sejtek öregedésében, hanem a sejtciklus megállításában, illetve az 

apoptózis kezdeményezésében is részt vesz. 

 

Apoptózis gátlása: 

 

 Az anti-apoptotikus hatású Bcl-XL, Bcl-2, Bcl-w fehérjék a sejttúlélésben játszanak közre, 

élettartamot hosszabítanak sejthalál adapterekhez kötődve, így meggátolják a kaszpáz aktiváló 

képességet. 
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Az apoptózis és nekrózis képekben szemléltetve 

 

 

1. ábra Az apoptózis eleje 

.  

2. ábra Az apoptózis vége 

(A videófelétel a DVD mellékleten az I. DVD-n található apoptózis melanoma HaCat file) 

 

 

3. ábra A nekrózis kezdete 

  

4. ábra A nekrózis vége 

(A videófelétel a DVD mellékleten az I. DVD-n található a HaCat nekrózis file.) 
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A Long-Term Scan rendszer 

 

Felépítés: 

A long-term scann renszert két inverz mikroszkóp alkotja melyek egy sejttenyésztésre 

alkalmas CO2 inkubátorban helyezkednek el. A mikroszkópok objektívjéhez egy-egy nagy 

érzékenységű CCD kamera van csatlakoztatva. A kamerákat vezérlő egység soros porton 

keresztül kapcsolódik a számítógéphez. A vezérlés feladata a világítás be- és kikapcsolása, a 

kamera kiválasztása, és a kamerák közötti átkapcsolás. 

A számítógépen a munkacsoport által kifejlesztett szoftver segítségével végezzük a képek 

rögzítését. Lehetőségünk van a szoftver segítségével a kamera kiválasztására (eszköz 

kiálasztása, eszköz beállítása), és a fény beállítására is. A beállítások között kiválaszthatjuk és 

menthetjük az aktuális nézetet. A szoftver használatával megoldhatóvá válik az esetleges 

képhibák szűrés (cut margins), a készítendő képek információ tartalmának növelése 

(Averaging, Auto intensity, Grayscale 9 bit (SIVA), Display transfer), illetve a képi adatok 

értelmezhetőségének elősegítése (Negative, Histogram, Grayscale, Distance) A mentés 

panelen a képtárolás formátumát is változtathatjuk (BMP, agy JPEG formátum). A szoftver 

lehetővé teszi az interneten keresztül történő távvezérlést is. 

 

 

5. ábra A Long-Term Scann rendszer fotója 
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6. ábra A LTS rendszer sematikus felépítése 

 

Működés: 

 

A rendszerben működő két azonos felépítésű video mikroszkóp segítségével az egyazon 

tenyészetből származó kontrol, és a kezelt sejtpopulációk egyidejű vizsgálata is 

megvalósítható. A rendszerrel végzett vizsgálataink során meghatároztuk számos citotoxikus 

ágens sejttenyészetekre gyakorolt hatását. 

 Bizonyítottuk, hogy rendszerünkben a citotoxicitás kvantitatívan jellemezhető, 

karakterisztikus változásokat hoz létre mind celluláris, mind pedig populációs szinten (7). A 

citotoxicitás kromatinszintű megnyilvánulását szinkronizált sejtpopulációkon sztenderdizált 

kromatinszerkezet elemzéssel vizsgáltuk (3, 5, 6). Az LTS rendszerrel megvizsgált 

tenyészetekből izoláltuk a sejtmagokat, és reverzibilis permeabilizálást követően a feltárt 

sejtmagok kromatinstruktúráját fluoreszcens mikroszkópiával elemeztük (8). Bizonyítottuk, 

hogy az interfázisos kromoszómák metafázisos kromoszómákká szerveződése (a kromatin 

kondenzálódás) morfológiailag jól jellemezhető módon zavart szenved citotoxikus hatásokra 

(9, 10). A kiváltott kromatinkondenzálódási zavarok jellegzetes kondenzálódási intermedierek 

megjelenését eredményezik.  

A bemutatott rendszer és metodika alkalmas különböző hatóanyagok citotoxikológiai 

vizsgálatára, mert a klasszikus citotoxicitást jellemző kvantitatív paramétereken túl lehetővé 
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teszi a lokális korai sejtválasz megfigyelését olyan koncentrációtartományban, mely 

sejtpopulációs szinten még nem okoz észlelhető változásokat. Ez a vizsgálati rendszer 

különösen akkor előnyös, ha a citotoxikus ágens megoszlása az inkubációs közegben 

heterogén, illetve ha a sejt-sejt kölcsönhatások kiemelt jelentőséggel bírnak. A várható 

eredmények elősegítik a sejtek citotoxikus hatásokra adott egyedi és populációs szintű 

válaszának mélyebb megismerését.  

 

Az LTS rendszer az alábbi külső kutatások során került felhasználásra: 

 Primer sejtkultúrák differenciálódásának vizsgálata. 

 Heterogén összetételű (HaCat/Melenoma) sejtpopulációk celluláris interakciói. 

Melanoma sejtekről készített videofelvételt a II. DVD-n található Melanoma20061116 

elnevezésű fájlban figyelhetünk meg.  

 Tumor-bioassay vizsgálatok. 

 Nanoszelén részecskék celluláris hatásai. 

 Patogén gombák és HaCat monolayer interakciója. 

 Nehézfémek, UV és gamma-sugárzás, illetve oxidatív stressz vizsgálata. 
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Time lapse imaging rendszer alkalmazása  

 

A sejtek tenyésztési körülményei  

 

A kutatásaink során szuszpenziós, (K-562, humán eritroleukémia sejtvonal) és adherens 

(HaCaT humán keratinocita immortalizált sejtvonal) sejtkultúrákat vizsgáltunk különböző 

toxikus anyagok jelenlétében. 

A sejteket RPMI-1640 tápfolyadékban tenyésztettük. A médiumhoz 10% FBS-t és 1% 

antibiotikum-antimikotikum keveréket adtunk kiegészítésként.  

A sejteket a kísérletek teljes időtartama alatt,- a long term scann vizsgálatok teljes időtartamát 

is beleértve- fiziológiás körülmények között tartottuk (37 °C és 5 % CO2). 

A tenyésztés során mindkét sejtvonalnál a kiindulási sejtszám 106 sejt per milliliter volt. A 

letapadó sejteknél (HaCaT) a vizsgálat megkezdése előtt megvártuk, míg a konfluencia 

mértéke eléri a 70-80%-ot, azaz a sejtek benövik a rendelkezésre álló terület 70-80%-át. 

A Long-Term Scan vizsgálat a legtöbb esetben 15 órás, vagy ennél hosszabb időtartamot ölelt 

fel. Abban az esetben, amikor a sejtek pusztulása a kezelést követően szinte azonnal 

bekövetkezett, nem tartott 15 órán keresztül a megfigyelés pl.: HaCaT sejtek esetében 50 µM-

os AgNO3 koncentrációnál  

 

A munkánk során az alábbi kutatásokban vettünk részt:  

 Toxikológiai kutatásaink során vizsgáltuk a különböző nehézfémek citotoxikológiai 

hatásait. A mi hallgatói csoportunk az ezüst-nitrát citotoxikológiai vizsgálatát végezte 

el. 

 A toxikológiai vizsgálataink során megfigyeltük a keresztes vipera (Vipera berus) 

mérgének sejtekre gyakorolt hatásait. 

 Ipari megrendelésre elvégeztük a sejtmentes fermentlé toxikus hatásának vizsgálatát 

humán sejtkultúrára. 

 A különböző korú sejttenyészetek viselkedésének, morfológiájának 

összehasonlításával a munkacsoportunk tanulmányozta a sejtek kísérleti körülmények 

között lezajló fejlődését. 
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Toxikológiai vizsgálataink  

Nehézfémtoxikológia 

A nehézfém toxikológiai vizsgálatok során a különböző nehézfémek toxikus hatásait 

vizsgáltuk a sejtek szintjén. 

 

 

Ezüst-nitrát HaCaT és K-562 sejteken (8) 

 

A szakirodalomban közölt Ld50 koncentrációk alapján hasonló koncentrációkat használtunk a 

vizsgálataink során. Mindkét sejttípusnál ugyanazokat az ezüst-ion mennyiségeket használtuk. 

Az ezüst ionok citotoxikológiai hatásainak vizsgálatával megállapítottuk a minimális gátló 

koncentrációt: ez az a legkisebb koncentráció, ami sejtek növekedését 50%-ban gátolja.  

Ez a koncentráció érték HaCaT sejteknél: 6,4 mikroM AgNO3 milliliterenként, K-562 

sejteknél: 3,5 µM AgNO3 milliliterenként. 

További eredményeink az ezüst citotoxikológiai hatásaira: 

Az ezüst-nitrát hatása függ a koncentrációtól: a különböző ezüst koncentrációk jelenlétében a 

sejtpusztulás és az ezüstionok mennyisége között egyenes arányosság figyelhető meg. 

 

 

7. ábra (A) a HaCaT és a K-562 (B) sejtek) sejtek növekedésének gátlása különböző ezüst-nitrát 

koncentrációk jelenlétében 

. 

A. A kilenc HaCaT sejtkultúra esetében a kiindulási sejtszám 106 sejt/ml volt. A kontrollhoz 

viszonyítva bekövetkező növekedésváltozás látható a különböző ezüst-nitrát kezelések után. 
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B. A K-562 sejtek növekedése látható a vizsgált ezüst-nitrát koncentrációk jelenlétében. A 

kiindulási sejtszám ez esetben is 106 sejt/ml volt. A kontroll populációkak nem kezeltük (C) A 

kezelés után minden esetben viabilitás vizsgálat történt. 

 

Bebizonyítottuk, hogy az ezüst-nitrát toxicitása koncentrációfüggő. A HaCat sejtkultúránál 

(106 sejt/ml) 0.5- és 50µM-os koncentrációjú AgNO3oldattal 15 órán keresztül és 37°C-os 

hőmérsékleten kezeltük a sejteket. A kontrollt nem vetettük alá AgNO3-os kezelésnek. Az 

ezüst-nitrát (≤ 0,1 µM) szubtoxikus szintjei nem okoztak toxicitást.  

Feltűnő változásokat tapasztaltunk a túlélését tekintve, 0.5, 5, 10, 15, 20, 30 és 50µM Ag-ion 

jelenlétében, ennek megfelelően 28, 47, 52, 58, 62, 67 és 75%-os sejtveszteséget figyeltünk 

meg. A minimális gátló koncentráció HaCat sejtek esetében 6.4 µM AgNO3. Hasonló, de 

némiképp magasabb sejtpusztulási arányt figyeltünk meg. Ugyanazon koncentrációk mellett 

K562 sejtek esetében :32, 54, 60, 64, 69, 72 és 77%-os sejtpusztulást tapasztaltunk. A MIC 50 

érték K562 sejteknél: 3,5 µM AgNO3. Ebből arra következtethetünk, hogy a K562 sejtek 

érzékenyebbek az ezüst-nitrátra, mint a HaCat sejtek. 

 

A HaCaT sejtek esetében a time-lapse imaging módszerrel az alábbi jelenségeket figyeltük 

meg: 

0,5µM-os Ag-ion koncentrációnál a sejtek osztódásai normális ütemben zajlottak, mozgásuk 

dinamikája megfelelő, azaz számottevő hatást nem figyeltünk meg ebben az esetben. 

Enyhe változást az 5µM-os Ag koncentrációnál figyelhettünk meg. A sejtek osztódásának 

dinamikájában csökkenő tendencia következett be. A 10 µM-os Ag koncentrációnál az 

osztódások sebessége tovább csökken, a sejtek nagy része osztódás közben elpusztul, a 

tenyészet nem képes a 100%-os konfluencia szint elérésére. 

15 µM-os Ag koncentrációnál még viszonylag sok sejt osztódik, de az osztódások sebessége 

csökken, és a sejtek letapadásának időtartama nő. 

20 µM-os Ag koncentrációnál a monolayer egy része paralízist szenved, a sejtek mozgása 

megbénul. Ez a folyamat belülről kifelé terjed. 

30 µM-os Ag koncentrációnál a monolayer megmerevedik, gyors nekrózis következik be a 

kisebb konfluenciájú tenyészeteken. A 100%-os konfluenciájú tenyészeten még látható 

osztódás, de itt is gyorsan végbemegy a sejtek pusztulása. 

50 µM-os Ag koncentrációnál az ezüst-nitrát hozzáadását követően a monolayer azonnal 

felszakad, és a sejtek nekrózissal történő pusztulása figyelhető meg.  
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8. ábra HaCat sejtszám változás 0,5 µM-os ezüst-nitrát koncentrációnál 

 (A videó felvétel az I. DVD-n található.) 

 

 

9. ábra. HaCat sejtszám változás 10 µM-os ezüst-nitrát koncentrációnál 

 (A videó felvétele az I. DVD-n található.) 

 

 

10. ábra: Halott sejtek száma 30µM koncentrációnál 100%-os konfluencián 

 (A videofelvétel a DVD mellékleten 1 .DVD) 
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Publikált kutatások 

 

A tanszékünkön már számos vizsgálat történt a nehézfémek sejtekre gyakorolt hatásainak 

tanulmányozására. Ezen vizsgálatok közül már több jelent meg nemzetközi folyóiratokban 

publikálva. 

A nehézfém-toxikológiai vizsgálatok a fent leírt, a tanszéken kifejlesztett metodika alapján 

zajlottak. 

 

Higany-acetát hatásai K-562 sejteken: (2) 

A hosszú távú megfigyelések során az alábbi eredményeket tapasztaltuk: 

Az 1 µM és az ez alatti Hg(II) ion koncentrációk nem toxikus hatásúak. A 10 µM-osnál 

magasabb higany koncentrációnál apoptózis jellemző, 100 µM-os higany koncentráció felett a 

sejtek mérete megnő, nekrózis következik be. (3. ábra) 

 

Nikkel-klorid hatásai K-562 sejteken: (9) 

Munkacsoportunk Meghatározta a MIC50 értékét, ami 2 µM, ami azt mutatja, hogy a Ni(II) 

ionok már kis koncentrációban is toxikus hatásúak voltak.  

A kezelés a magasabb Ni(II)-ion koncentrációknál (10-50 µM) nem okozott intenzív mozgást 

az apoptózis során,de a 100 µM-os koncentráció fölött már mozgásintenzitás növekedést 

figyelte meg ez azonban csak időszakos volt. 

A magasabb koncentrációkon a sejtek méretének növekedése volt megfigyelhető, ami a 

nekrózis felé való átmenetet mutatja az apoptózis felől. 

Jellemző hatást figyelte meg a 100 µM-os koncentrációnál. (4. ábra) 

A nikkel károsítja a sejtmembránt, ami felszakad, így a sejtek a tartalma a külvilágba kerül. 
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Time-lapse imaging a különböző nehézfémek hatásairól: 

 

11. ábra Higany-acetát jellemző hatása K-562 sejtekre 100µM 

 (A videofelvétel a DVD mellékleten: I DVD) 

 

 

 

12. ábra Nikkel-klorid jellemző hatása K-562 sejtekre 100µM 

(A videofelvétel a DVD mellékleten: I DVD) 
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Vipera berus toxin hatásai HaCaT sejtekre 

 

A vizsgálat során tisztítatlan, szűretlen „nyers” mérget használtunk, tehát a mérget a lefejés 

után nem kezeltük tovább.  

A viperaméreg tartalmazta a vipera szájában természetes körülmények között ott lévő 

baktériumflórát, illetve a méreg lefejése során belekerült egyéb szennyezőanyagokat is. 

A Vipera berus toxinjának fő összetevői közé tartoznak a neurotoxinok, és a myotoxinok. A 

neurotoxinok az ideg-izom közötti ingerület átvitelt megakadályozva bénulást okoznak.  

A myotoxinok emésztőenzimekből levezethető fehérjék csoportja. Főképp az izomsejteket 

károsítják. A Vipera berus mérgében a foszfolipáz-A mennyisége jelentős. 

A tenyészeten főképp a myotoxinok hatása érvényesült. 

 

A vizsgálatban használt méreg-hatóanyagok: 

 

Hozzáadott toxin 

mennyisége (µl) 

Tápfolyadék mennyisége  

(ml) 

Toxin végső mennyisége  

( g/ml) 

0,1 4,5 6,2*10-8 

0,5 5,1 2,74*10-7 

0,7 4,8 4,08*10-7 

1,2 4,9 6,85*10-7 

5 5,2 2,689*10-6 

5 4,9 2,854*10-6 

13. ábra A Vipera berus toxin végső hatóanyag mennyiségei. 

 

A toxin hatása a legkisebb koncentráción és nagy konfluencián - a vizsgálat első felében ezt a 

koncentrációt 100%-os konfluencián vizsgáltam-, még nem figyelhető meg. A sejtek normális 

ütemben osztódnak, mozgásuk is dinamikus. Nekrózisra utaló jel nem látható a képeken.  

A kisebb konfluenciájú tenyészeteken - a vizsgálat második felében – 70-80%-os konfluencia 

esetében- azonban, a sejtek toxinnal való nagyobb felületen történő érintkezése miatt gyorsan 

bekövetkezik a méreg hatása. A sejtek mozgása megbénul, paralízist szenved, a monolayer 

felválik, a sejtek nagy többségénél nekrózis következik be. 
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A nagyobb konfluencián 90-100% a sejtek szorosan egymás mellé csoportosulnak, és védik 

magukat és egymást a toxin hatásaitól. A konfluencia mértéke jelentősen befolyásolja a 

toxikus hatást (a nagyobb konfluenciájú tenyészetek hosszabb ideig életben maradtak a védő 

funkció miatt, emellett a magasabb sejtszám nagyobb puffer rendszer kapacitást biztosít a 

toxinban lévő enzim emésztő funkciója ellen). 

A nagyobb toxin koncentráción ezek folyamatok gyorsabb lefolyásúak, a sejtek kevésbé 

tudnak védekezni az emésztő funkció ellen. 

Szakirodalmi adatok alapján a Vipera berus méregnek egéren az LD50 értékei: intravénásan 

vérbe kerülve: 0,55 µg/g; intraperitonealisan a véráramba kerülve: 0,80 µg/g; bőr alá 

szubkután: 6,45 µg/g. (10)  

Mi a legkisebb koncentrációnál, ahol 6,2*10-8 g/ml volt a toxin hatóanyagtartalma ez 

átszámolva 0,062 µg/g is érzékelhető hatást tapasztaltunk a kisebb konfluenciájú 

tenyészeteknél. Ezek alapján megállapítható, hogy mi már egy nagyságrenddel kisebb 

koncentrációnál is megfigyeltük a méreg hatását.  

 

A viperatoxin hatásai 0,1 µl koncentrációnál a különböző konfluencia értékekenképekben 

szemléltetve: 

 

 

 

14. ábra0,1 ul toxin hatása 100% konfluencián, kép a tenyésztőedényről 10X objektív Giemsa festés 
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Képek a tenyészetekről 0,1 µl toxin hatása a long-tern scann felvételei: 

 

 

15. ábra 0,1ul toxin 70%-os és 100%-os konfluencián a felső kép a 0. percben készült 

 

 

A viperatoxin hatásai 5 µl-es koncentrációnál, különböző konfluencia értékeken szemléltetve: 

 

16. ábra ul toxin hatása 100% konfluencián, kép a tenyésztőedényről 10X objektív Giemsa festé 
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Képek a tenyészetekről 5 µl toxin hatása a long-tern scann felvételei: 

 

17. ábra5 ul toxin 70%-os és 100%-os konfluencián a felső kép a 0. percben készült 

 

 

 

Eredményeink a képek elemzése után grafikonon ábrázolva a következők lettek: 

 

 

 

 A viperatoxin hatásai HaCat sejteken, 0,1 µl toxin különböző konfluencia értékeken: 

 

 
18. ábra0,1 ul toxin 70-80%-os konfluencián történő sejtszám változás az idő függvényében 

 (A videofelvétel a DVD mellékleten: II DVD Vipera_toxin_0,1mikroliter_70%konf.file) 
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19. ábra: 0,1 ul toxin100%-os konfluencián történő sejtszám változás az idő függvényében 

(A videofelvétel a DVD mellékleten: II DVD Vipera_toxin_0,1 mikroliter_100%konf. file) 

 

 

 

 

 

 

 

 A viperatoxin hatásai HaCat sejteken, 5µl toxin különböző konfluencia értékeken: 

 

 
20. ábra5 ul toxin 70-80%-os konfluencián történő sejtszám változás az idő függvényében 

 

(A videofelvétel a DVD mellékleten: II DVD Vipera_toxin_5mikroliter_70%konf. file). 
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21. ábra: 5 ul toxin 100%-os konfluencián történő sejtszám változás az idő függvényében 

 (A videofelvétel a DVD mellékleten: II DVD Vipera_toxin_5mikroliter_100%konf. file). 
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A sejtmentes fermentlé hatásai HaCaT sejtpopulációra 

 

 

A time-lapse imaging rendszer ipari alkalmazásba is került, amikor Neurospora crassa és 

Penicillium chrysogenum által termelt fermentlevet kellett vizsgálnunk. A mintáknak nem 

tudtuk a nevét, különböző kóddal ellátott mintákat kaptunk. Az elfogulatlan értékelés miatt a 

fermentlében lévő fehérjék koncentrációját illetve a fermentlé egyéb jellegzetességeit sem 

ismertették velünk.  

 

A vizsgálat célja az volt, hogy a sejtmentes fermentlében lévő Neurospora crassa és 

Penicillium chrysogenum által termelt fehérjefrakciók a humán sejtekre toxikus hatással 

vannak-e. 

 Fermentlé tapasztalatok: A kontrollhoz képest a kezelt sejtpopulációknál a hatások az idő 

függvényében nyilvánultak meg: kezdetben a kezelt sejtek a kontroll sejtekhez képest 

hasonlóan viselkedtek, de az idő előrehaladtával a mozgásuk lassult, és az osztódásuk 

sebessége is csökkent. Az apoptózisok száma nőtt. Később már az osztódni feljövő sejtek sem 

tudták befejezni az osztódást: feljőve megbénultak. 

A baktériumok száma is megnövekedett, a videón is jól látható a baktériumok mozgása. 
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Az első órában bekövetkező % -os sejtszám változás: 

 

 

22. ábra Sejtszám %-os változása az idő függvényében 

 

 

 

23. ábra a sejtek osztódása az idő függvényében 
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In-vitro evolúció HaCaT sejteken  

 

 

A munkánk során a különböző korú tenyészeteket megfigyelve több viselkedési, morfológiai 

eltérést tapasztaltunk. Az idős tenyészetek viselkedésében számos eltérést figyeltünk meg. 

Ezek a tapasztalatok indították el az ilyen jellegű kutatásainkat. 

A vizsgálatok során több idős - több passzálást és fagyasztást megélt-, és egy fiatal, - ötször 

passzált -, HaCaT sejtpopulációt hasonlítottunk össze. 

Az általunk megfigyelt legfontosabb eltéréseket három csoportba osztottuk. 

 Morfológiai eltérések közül nagyon szembetűnő jelenség, hogy az idősebb sejtek 

citoplazmájában egy vagy több kisebb-nagyobb vakuolumot láthatunk. Ezek a 

vakuolumok gyakran az osztódást követően is megmaradhatnak. 

 A sejtek viselkedésében is kisebb-nagyobb eltéréseket vettünk észre. A sejtek 

generációs ideje hosszabb, az osztódások lassabban mennek végbe. A letapadás 

időtartama is hosszabb, illetve a sejtek mozgási dinamikája is kisebb.  

 A sejtek osztódási mechanikájában is jelentős eltéréseket tapasztaltunk. Az anyasejtből 

gyakran kettőnél több utódsejt keletkezik. Ezek az „utódsejtek” néhány esetben csak 

lefűződött citoplazma-fragmentumok. 

 

 

 

24. ábra normál HaCaT sejt 
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25. ábra HaCaT sejt vakuolumokkal 

 

 

26. ábra HaCaT sejt osztódás előtt 

 

 

27. ábra négyfelé osztódott HaCaT sejt 

 

(A videókat a DVD mellékleten a II. DVD-n a HaCat in vitro evol., HaCat kontroll in vitro 

evol. 2 és HaCat kontroll in vitro evol. file tartalmazza.) 
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Korábbi vizsgálataink a time-lapse imaging redszerrel  

 

Nehézfém toxikológia: A tanszéken folyó kutatásaink során a kadmium, az ólom, az uranil-

acetát toxikológiai vizsgálatait a már fent leírt módon végeztük el. 

 

Primer sejtvonalak differenciálódásának vizsgálata: He/De: (hepatocelluláris carcinoma) és 

Ne/De: (mesoblastos nephroma) primer sejtkultúrák indítása, differenciálódás illetve 

nehézfém toxikológiai vizsgálatokat is végeztünk.  

( A videofelvétel a DVD mellékleten: II DVD a NeDe20061110 file). 

 

HaCaT- Candida interakcióját is vizsgáltuk szérumtartalmú és szérummentes médiumban. 

Szérummentes közegben nevelve a Candida sejtek megtámadták a HaCaT sejteket, és 

nitrogén forrásként használták őket. Erre a tenyészetre jellemző volt, hogy a hifák rövid 

morfológiájúak mindaddig, míg nem áll rendelkezésükre megfelelő mennyiségű nitrogén. A 

szérumtartalmú médiumban a hifák hosszú morfológiája figyelhető meg, illete ez esetben a 

Candida sejtek nem támadják meg a HaCaT sejteket.  

(Az interakcióról készült videót az I. DVD-n található HaCat+Candida000001 nevű fájlban 

található.) 

Növényi embrióklónok növekedését is megfigyeltük az LTS rendszerrel. A növényi 

embrióklónok növekedése egy 9000 percet felölelő vizsgálatot jelent. Az első és az utolsó 

képet összehasonlítva jól látható a méretbeli különbség.  

(A videó a DVD mellékleten a II. DVD-n található a Növényi embrió nevű fájlban.) 
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Képanalízis ImageJ program használatával 

 

Az ImageJ program bemutatása 

 

 Az ImageJ-ről általánosan 

Az ImageJ egy nyílt forráskódú Java-alapú képfeldolgozó rendszer. Futtatása bármely 

platformon lehetséges asztali alkalmazásként vagy akár online appletként is. A program 

használatához Java 1.4 futtatókörnyezet szükséges. Az ImageJ az egyik leggyorsabb tisztán 

Java nyelven írt képfeldogozó keretrendszer. A program számos kényelmi funkcióval 

rendelkezik. Makrók írásával több műveletet egymás után fűzhetünk, és ha nem lenne 

elegendő az így elérhető funkciók száma, akkor akár saját plugint is írhatunk a programhoz. 

Ehhez sok példát találunk a program honlapján. Az ImageJ-t akár függvénykönyvtárként is 

használhatjuk.  

Több adattípust is támogat, ilyenek a 8-bites szürkeárnyalatos, illetve indexelt színes, 16-bites 

előjel nélküli egész, 32-bites lebegő pontos és RGB színes adattípusokat. Számos 

képformátumot támogat:TIFF, GIF, JPEG, BMP, DICOM, FITS.  

Az ImageJ-ben elérhető különböző eszközök segítségével képeket megjeleníthetjük, 

nagyíthatjuk (1:32-től 32:1-ig) és görgethetjük. 

Az épp aktív képen kijelölhetünk területeket. A kijelölések lehetnek téglalap, ellipszis, illetve 

szabálytalan alakúak is. Kijelölés után a műveletek a kijelölt területen hajtódnak végre. 

Az ImageJ-ben található több képjavító, helyreállító művelet. Többek között tudunk simítani, 

élt detektálni, medián szűrést, illetve küszöbölést végrehajtani 8-bites szürkeárnyalatos és 

színes képeken is egyaránt. A fényerő és a kontraszt interaktívan állítható. 

A rendszer képes geometriai műveletek futtatására. Képrészletet vághatunk ki, skálázhatunk, 

átméretezhetünk. 

 

Az ImageJ bővíthetősége  

Az ImageJ beépített függvényei kibővíthetőek több módon is. Lehetőség van macro, script és 

plugin írására. Ezek a módszerek különböző komplexitású feladatok megoldására alkalmasak. 

Minden esetben az adott feladat határozza meg, hogy ezek közül mely módon bővítsük ki a 

rendszert. 
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A macro nyelv segítségével képfeldolgozó műveletsorokat hozhatunk létre. Legegyszerűbb 

módja a macrok előállításának, ha a program segítségével felvesszük a műveleteket. A macro-

k egyszerű szöveges fájlok. A macro telepítéséhez nem kell mást tenni, mint a programban a 

Plugins=>Macros=>Install... menüpont segítségével megkeresni a telepíteni kívánt szöveges 

fájlt. Lehetőség van egy fájlon belül több macro írására is. 

Ha a rendszert scripttel szeretnénk bővíteni, akkor már több eszköz áll a rendelkezésünkre. 

Egyrészt a nyelve gazdagabb, mint a macro nyelv mivel JavaScriptben írjuk. Másrészt teljes 

hozzáférésünk van az ImageJ és a Java API-hoz. Ennek a módszernek is vannak hátrányai, 

mivel a JavaScriptben írt műveletsorok lassabban futnak, mint a macro nyelvben írtak, és nem 

érhető el a legtöbb beépített macro függvény. 

Az ImageJ bővítésének harmadik módja, ha Java nyelven plugint írunk hozzá. Számos a 

programban elérhető parancs is pluginként van implementálva. Látható, hogy ennek a 

módszernek a nagy előnye, hogy így a teljes standard Java API elérhető, és akár harmadik 

féltől származó könyvtárakat is használhatunk. 
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Az ImageJ használata sejtszámoláshoz és animáció készítéséhez 

 

Sejtszámolás 

Lehetőségünk van az adott képen vagy egy képsorozaton a sejtek számában történő 

változások megmérésére. A kapott adatok kiértékelése történhet grafikon segítségével, melyen 

az idő függvényében prezentálhatjuk a változásokat. 

A számolás menete: 

1.) ImageJ program elindítása 

2.) képsorozat betöltése: File=> Import=> Image Sequence… paranccsal 

3.) fény és kontraszt beállítása a menü Image=> Adjust=> Brightness/Contrast… 

  segítségével 

4.) következő lépésben a képek elő-ill. hátterének elválasztása a Threshold funkcióval 

• A leggyakrabban alkalmazott image processing eljárások közé tartoznak a 

thresholding (küszöbölés) és a szegmentáció. A lényegük: bizonyos szempontok 

alapján területekre osztjuk a képet 

• "Foreground/Background" szétválasztási műveleteknek is nevezik őket, ami arra utal, 

hogy az eljárás a kép egy adott tulajdonságára koncentrál, és a többit eldobja 

5.) ezután a sejtek megszámolása történik az Analyze=> Analyze particles… paranccsal 

6.) a kapott eredmények átvitele az Excel programba, és grafikonon ábrázolás 

 

A thresholding művelet lényege és megvalósítása  

1. kiválasztjuk a kép egy bizonyos szürkeintenzitás tartományát 

2. az ebbe a tartományba eső pixelek alkotják a "foreground-ot" (előtér) 

3. a többi pixel alkotja a "background-ot" (háttér) 

Az eredmény: bináris kép 

Az előtér vagy fehér vagy fekete (általában) 

A thresholding-ra a hisztogram szolgál útmutatásul. Különböző szürkeintenzitás értékek 

kiválasztásával megváltozik a képi információ. 

 

A thresholding módszerét felhasználhatjuk: 

1. textúra analízis 

2. határvonalak kiemelése 
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3. képi alapjellegzetességek (feature) kiemelése 

4. kép elôkészítése további mérésekre 

 

Animáció 

Azonos időközönként készített képek sorozatából animációk létrehozása, pl.: GIF 

formátumban. Itt lehetőség van egy adott képrészlet kiemelésére illetve kivágására, és ebből 

animáció készítésére. 

Menete, egy sejt kiválasztása, ill. kivágása esetén: 

 1.) ImageJ program elindítása 

 2.) képek betöltése a File=> Import=> Image Sequence… paranccsal 

 3.) a betöltés után egy stack-et kapunk, ez egy képsorozat, a csúszkával léphetünk a képek

  között 

 4.) a kívánt sejt kiválasztása után a File=> Crop paranccsal az összes lépen kivághatjuk az 

  adott részt 

 5.) végül a File=> Save as=> Gif… utasítással GIF formátumú animációt kapunk  

 

Generációs idő meghatározása 

   

Az ImageJ programban lehetőség van a generációs idő kiszámítására, mely egy sejtből történő 

sikeres osztódást követően keletkezett 2 utódsejt újbóli osztódása között eltelt időt jelenti. 

A vizsgálni kívánt képekből előállítunk egy Stack-et, melyből kivághatjuk azt az osztódó 

sejtet, amire kíváncsiak vagyunk az Image=> Crop paranccsal.  

Az ezt követően kapott új Stackből a Plugins=> 3D=> ImageJ 3D Viewer opcióval 

készíthetünk egy voxeltömböt. 

Miután betöltött az ablak az Edit=> Display as=> Orthoslice menüpontnál beállíthatjuk, hogy 

a síkok vetületeit mutassa, így jól látható a sejt osztódásának helye, a sejt mozgásának iránya 

és a következő osztódás is. A Z tengely hosszúsága megegyezik a képek számával, így az első 

osztódás végétől a következő osztódás végéig tartó szakasz hosszúsága meghatározható. 

Mivel azonos időközönként készültek a képek, a mért hosszúság átváltható percbe, illetve 

órába. 
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Videó készítése 

 

Videó felvétel készítése, melyen jól vizsgálhatók a sejtetológiai tulajdonságok, sejtek 

osztódása, illetve sikertelen osztódáskor bekövetkező apoptózis.  

Videó felvétel készítésére a VirtualDub nevű programot használtuk. A VirtualDub ingyenesen 

letölthető. 

 A programmal nagyméretű fájlokkal (akár 4 GB fölött) dolgozhatunk, lehetőséget biztosít a 

felhasználónak egy videóban különválasztani a hangot és a képet egymástól. 

AVI és MPEG filmek szerkesztésére alkalmas program, amellyel az animációkon effekteket 

is alkalmazhatunk, újraméretezhetjük őket, valamint a hangot, ill. a képet önmagában is 

kimenthetjük. 
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Összefoglalás 

 

Különböző sejtek viselkedésmorfológiai vizsgálata és összehasonlítása fontos adatokat 

tartalmaz számunkra, melynek tudatában eddig ismeretlen információkat ismerhetünk meg. 

Kísérleteink során a Long Term Scan Módszer használatával percenként fotókat készítettünk, 

így nyomon követhettük a sejtek által kialakított sajátos viselkedésbeli mintázatot, majd e 

képek sorozatából videót állítottunk össze. Ezeknek a videóknak a tanulmányozásával a 

megfigyelt sejtpopulációból módunkban állt kiválasztani egy, vagy több sejtet, és nyomon 

követni milyen változásokon esik, vagy esnek át. Kísérleteink során nehézfémek 

toxikusságának (ezüst, nikkel, kadmium, ólom és uranil-acetát) kifejeződését vizsgáltuk, 

humán keratinocita (HaCat) és eritroleukémia (K562) sejteken. Ezeken a sejteken elvégzett 

kísérletekből készített képeket elemeztük ImageJ program segítségével. A képanalízis során 

információt kapunk a sejtszám változásairól: követni tudjuk a sejtosztódásokat, a sejtek 

mozgási dinamikáját, illetve vizsgálni tudjuk a generációs időket. 

A bemutatott metodika és rendszer lehetővé teszi, hogy különböző hatóanyagok 

citotoxikológiai vizsgálatát az idő függvényében elemezzük. Így lehetővé válik, hogy 

nemcsak a toxikus hatást vegyük észre, hanem a korai sejtválasz jelenlétét is olyan 

koncentrációértékben, mely a sejttenyészet szintjén még nem fejtette ki észlelhető hatását. A 

nagyobb koncentrációparamétereket használva a nagyobb sejtpopulációkat érintő sejthalál 

típusok folyamata nyilvánult meg. A time-lapse imaging rendszer nagyon érzékeny módszer, 

hiszen alkalmazásával vizuálisan már a legkisebb változást is képesek vagyunk érzékelni.  

 

Az in vitro evolúció nagy jelentőséggel bírhat az elkövetkező időszakban, mivel eddig nem 

fordítottak megfelelő, elegendő figyelmet arra, hogy a sejteket folyamatos szelekciós nyomás 

éri (tápfolyadékcsere, fagyasztás stb). 

A time-lapse imaging rendszerrel végzett kutatásaink során kapott LD50 értékek minden 

esetben megegyeznek a szakirodalmi adatokkal, kontrollként szolgálva arra, hogy a 

rendszerrel egzakt módon mérünk. 

Ez a módszer különösen alkalmas arra, hogy a szubtoxikus dózisban adagolt vegyületek 

biológiai hatásait detektálhassuk. 
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Kitekintés: a time –lapse imaging rendszer a további vizsgálatokban 

 

A további munkánk során tervezzük a különböző tumorokból indított primer sejtkultúrák 

hosszú távú megfigyelését. A különböző páciensektől származó malignus tumorokból 

sejtizolálás és stabil sejtpopulációk létrehozása után, a sejt típusát meghatározzuk, és a time-

lapse imaging rendszerrel a sejteket megfigyeljük. Ezen primer sejtvonalakat felhasználva 

szeretnénk vizsgálni a kemoterápiás szerek hatóanyagait, illetve kifejleszteni egy az adott 

tumor típusra, és a paciens igényeire szabott kemoterápiás kezelési módszert. 

A rosszindulatú daganatsejteken történő kemoterápiás szerek hatóanyagainak vizsgálatával 

viszonylag rövid idő alatt vizsgálhatjuk a szer sejtekre kifejtett hatását. 

A kíséreltetünk célja, hogy az adott páciens sejtjeire ténylegesen ható szereket a megfelelő 

koncentrációkban lehessen alkalmazni. A módszert megvalósítva a szabadalmazott és a még 

kísérleti stádiumban lévő gyógyszereket a páciens sejtjein vizsgálva elérhetjük, hogy a 

páciens nincs kitéve az adott szer mellékhatásainak. 

A long term scan rendszer hardver fejlesztését, ezen belül a fluoreszcens és a háromdimenziós 

képalkotás eszközfejlesztését is szeretnénk megvalósítani. 
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